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~ 1 = A A a ] o A
Tag guyteanyl aenuuuNIEEW ﬂammmmasagn1&1umtﬂmmmma"l%l

yinaan etloundsnu iy Tag Tasdndmsndeslduunnesdails Tag vilauoainl

=

9 o w A A A ] ) [ 9) " Y
1]'8']Elﬂ'licl,clfﬂ'lu%'lﬂﬂﬁ'lllﬂ'lq"llﬂiI,H_I9’]&(5]'85 LUBDLUABDINUA "l,iJﬁ'liJ'lﬁﬂu'lﬂaﬂiJ'ljelflﬁiJhlﬂ

Q

= = A A = ] = R
IUDIINAITUNITHANA Tag ﬁN]liJ’d'lllﬁﬂnJﬁEJ"LJLLTJG]LG]’E]?J"I,@ DITINITDOONUUUIIVIVUDN Tag

9
a

a <] v A | o
Inunszudlliioss novziiorgms Idauuuiudull Tag staiivzliniteanuiiniely

Ao w 1 [

] @ 19 o a A Iy
"]JL!Wﬂ’Viiy UNIag qqmazizszmiiuawagahlﬂa ‘I/'I'N'I‘lﬂ‘ll‘i.lil?ilﬂﬂﬂ ilJiy'lil!i‘Llﬂ’Ju"lﬂﬂ

31U 2.13 Active Tag [6]

© RFIDTrakker © Sokymat

LF
(Low Frequency)

AR YT

%
7 e w ) (High Fréquency)

(ultra High
Frequency)

D Alien

© Intermec L Rafsec

d’ Y d' 9 o 1 d'
3191 2.14 dnbuzved Tag N1Fiuugaza1ud [5]
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3) 159901 (RFID Reader)
9 A [ A 1 A A 1 A 1 A = 9
WNNANY09AT0981UAD NI UADINED U ToIVoUToYaaeUTag
F2 A AAa A 1 A A o A
arenaua1NdIng n1elunieseruazilsznoudie t@101MANRIINUARIANDILATTD
atoneuad tie 145 unIodedyn s MaTuLazaIAdId Y IUING 29ATAIVANAITOIUNT O

=S 9 £ o I o o [ a [ a 4
mﬂwuagamuﬂ%szu'mm]m’m"luiﬂiﬂauimmaai HAZAIUVDINITAANDNUADUNIUND T

1 Magnetic field

A

J Antenna

Driver

Y

Pulse generator

Envelope

Processing unit Filter & Limiter

-~

-~

Detector

s 2.15 Tassadrmeluniesen

(M) 1N309911 RFID LUUNAN (V) 11599811 RFID LUUAAKNIIA

(7) 139981 RFID nuuilseg

3111 2.16 130381 RFID 1A
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4 1 4 1 4 o A 1
Tasea31aneluniowd u RFID 11309811 RFID Heenlsznounanisunindiu
o a [ A a A ¢ A LY [ . d' A
Auladyaagidmasu(Pulse Generator) ANNANHINO ATy 19 110 1A D(Driver) oI
aussouz lumsdunaverei1as (Power Amplifier: PA) Fevimthn ludunszuane ludyau
1 o A ~ o o Y a 1 [ A @ = [
ao lldsuaana emilenivi ldinaaumiviandon e 116 Tag ymziferiuvaain

o =1 ° Y A d A v o v g = s o
@Nﬂﬁ'l’Jﬂ"l]%‘VI'I‘I’iu']1/]L‘]J‘Lll’ﬁllﬂUﬁ'lﬂﬂ'lﬂ'lﬁ’iﬂﬁﬂluillu1iuf1"l.l'lml,ilmaﬂﬂ’J'IiJﬂW'IWT]Qﬂ?J’E]@,LﬁG]mJ

Y
%’auﬁaa‘iuwwmm Tag NUUAIUATIVIVYDU (Envelope Detector) i]w‘hmmﬂﬂ%'ay”aaaﬂmﬂ
A

aduANuANIIazverIunsz e 1dsudnavesdeyaniuuasgiuaein tilodedehdiu

sEuranatoua (Processing Unit) 19 11) Tagnaliwirelszuranadeyanednielunsosoiu
ﬂ U g U U

=KX o

(RFID Reader) 1in1415lu'luTnsnouInsaans ¥esaneituiiogarelulysunsuazimii

a 1w a 4 1] 1 @ o

v 9 AW Yo o Y A
a@mwmaga (Decoder) Vlvlﬂi’Ul,l,ﬁg‘ﬂ'lﬂu1ﬂ@]ﬂ@]ﬂﬂﬂﬂﬂﬂ1ﬁl’)m@i:.i, IN aﬂymsm"lﬂmm

A ' ' ) 9 ' Aq YA A ] a @ A
Lﬂ§6\161u%$u@lﬂ@lNﬂuulﬂGHiJﬂizm‘ﬂﬂﬁ%NTL! LHU LL“IJ"U‘I/]I"])’&J?JGE]"]Ju1maﬂ LUUAARNUN 1150

v lnanlsze (Gate Size) Hananaga 2.16

2.2.4 RFID Reader

() RFID Reader U®4 Parallax [7] (V) RFID Reader ID-20 U84 ID Innovations [8]

RFID Reader Pinout Top

[ RoboticsComnectioncom

(A1) RFID Reader U9 Trossen Robotics [9] 1) RFID Reader U494 Phidgets [10]

317 2.17 RFID Reader ¥99U3HNA139)
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v 9
A A o ! b4

A ' s a A
Lﬂﬁi’)ﬁ'ﬁ]']l!@?i!,@wulﬂﬂ (RFID Reader) NUITNUIEIN Glummmumllmﬂuaz

[ I [ a & @ A 9 a a J o o = q’j 9

adsend NUDYNA1ITUA FIUMINAUBATOIAULUY mﬂimyg AIHIVUNANHIUU @109
d' d‘ dy 1 ] [ = =

lli’Nul‘]J‘Vl RFID Reader (411 Passive maamﬂm«ﬁmwuazs1m"lmmq MUEAUMSANET Taedl

09; ] = A a ' = = 1 v = Y A 9
MYIUANND 13.56MHz Loy 125KHz I BUADTIU/AVYIU HTDDT1UDYNUAYD 1mam1%

v
ya o

Tuaiseruil 396141800 RFID Reader 31 ID-12 404 ID Innovation [8] 111911

u

I a 1 1 o [ {
AMINAADI ID-12 1)1 RFID Reader ¥ia01u0e1A8? 11910 1ue1un11ud 125kHz Uage1ne
Tud Feazazainaed 14nsal ludeamsanugeenlumseenuuunsemaeemaimng au
9 ' 9 A Vo A 9 v o ad A A ' 2
g uaviinasansFoaen U g IMANBUBNIND TR MITUdYRMATUNTOBARGUNINUL

I J @ [
ANVUDINWATOITUIBUNU

- ID2 /ID12 /ID20 PIN-OUT

GHD
RES (Reset Bar)
ANT (Antenna)
ANT (Antenna)
CP
Future
+- (Format Selector)
D1 (Data Pin 1)
DO (Data Pin 0)
. LED(LED/ Beeper)
. +BY

® n

w o
eoeee
L L X2 ]
e - oW

=]

BOTTOM VIEW

-
L= == T [ LI VY U N Y

7% 2.18 31/919002A MUV 1V RFID Reader Ju ID-12 [8]

u

Aumian1davves d-12 Swau 11 1 uagnldaussalszunm 69 a1 Tag

o Y IS . A . P4 o A
awnsammuagiuuuvestoyaiili ASCIT, Wiegand26 1130 Magnet Emulation 1@ Iagsviuai
AUNUIVDINIITFONADUDIV 7 1B 1UTOYAIN Tag 1142 ID-12 9z dIUOYADONNIYT DO (V1
9) 1@z D1 (1 8) AIUAMTVTANNNMBN NV ID-12 taadluaisian 2.2 Tasimsnlseumoy

[

AUANTANUTUDUY YoIdNAAAeINY ID-12 Tiszozmsoruiszunm 12 wuamas (103
aygoe 1.d 9 ' {q o o
NAAvIs IddIndnanties) e1unNud 199U125KHz 5095UNAT§IUU09 Tag DY EM4001
[ { o 9 o . .
CERINTAINR Gllmaljaﬁﬁjmﬂ Tag 19n1509A5WaLiU1 Manchester Coding 64 bit %50 modulus 64

lnu lvinszuansa 5VDC Nnsie 13mA
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Parameters ID-2 ID-12 ID-20

Read Range NIA (no internal antenna) 12+ cm using 50mm IS0 card 16+ cm using 50mm IS0 card
Dimensions 21 mmx 19 mm x & mm 26 mmx 25 mm x 7 mm 40mm x 40mm x 9 mm
Frequency 125 kHz 125 kHz 125 kHz

Card Format EN 4001 or compatible EM 4001 or compatible EM 4001 or compatible
Encoding IManchester 64-bit, modulus 64 MManchester G4-bit, modulus 64 Manchester 64-bit, modulus G4

Power Requirement

SVDC @ 13mA nominal

SVDC @ 30mA nominal

SVDC @ 65mA nominal

110 Qutput Current

+-200mA PK

Woltage Supply Range

+4 .6V through +5.4V

+4.6V through +5.4V

+4.6Vthrough +5.4%V

ATNN 2.3 BFVUEMNUINIMAEHIINVDY ID-12

Description Magnet Emulation Wiegand26
Zero Volts and Tuning Capacitor
Fin 1 GND OV GMND OV GND OV
Ground
Fin 2 Strap to +5V Reset Bar Reset Bar Reset Bar
To External Antenna and Tuning
Fin 3 Antenna Antenna Antenna
Capacitor
Find To External Antenna Antenna Antenna Antenna
Fin 5 Card Present Mo function Card Present  * Mo function
PinG Future Future Future Future
Fin7 Format Selector (+/-) Strap to GND Strap to Pin 10 Strap to +5V
Fing Data 1 CMOS Clock* One Cutput *
Fin9 Data 0 TTL Data (inverted) Data * Zero Qutput *
Fin10 3.1 kHz Logic Beeper/LED Beeper/LED Beeper/LED
Pin 11 DC Voltage Supply +5V +5V +5V

* Requires 4K7 Pull-up resistor to ~3V

M50 23 uaasd sz niNvesnaee nsaiidesmsdeaisdoyauuy
o % A ' J Y Y . o % 1 o

Ascrl i laTasdounou 7 aans16 MIndoanisdoyauly Wiegand26 n'ld lasaev1 7

1 Y Y

UNA9918 +5VDC N30d03auuD Magnet Emulation 1#@0v1 7 AU 10 Fedoyans 3 guuuuil

H ' 4 A

wilsdagluuniivanandy  §1deansszezmse uNuINTuE TR INITAAAIT1801NA

Mononlasave e INAAINY 3 Hazy 4

T lFauausanldassdn 2.19  Tasaaduunasaie i

U

1590 ID-12

S L I [V o ) Y A 1 9 o
AszuaasvuIa 5 1ad suduszauusesu L mldaunsodeuas T ldauiy
4 1
TuTasaouTInsames 1a lagass M3 ldauausoas 1#31191091 DO (11 9) #5091 DI (U 8)
' ' ) ~ Yqg ¥ Y 1 . A a 99 '
dauanIuzyeInNseudoyanoniul 10 F199zAv9A0 Transistor 1NoaIAT IRnszua lnariu

. 2 ) % YA a Aaa v 9
Transistor clmzm"lﬂﬂm Buzzer 1tag LED GL‘VMJﬂﬁﬂi%Wﬁ‘}JﬂimﬂﬂJﬂﬁﬂTu"’U@yja
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Power In Ut LaES s vele COMPONENT LIST
(o3 3 w5 our}—2 - R1=100R
= 8 —_ Beepex i bt RZ=IK
o | ot 3 [++ LED Ri=1K
L A C1 = 100uF 16V

C2=100uF 10V
Beeper =2.7-3 5KHz 100R

D1 = 1N4001
1 é 2 D2 = GREEN LED
ID-12 Ul =LM7805
11 o I Q1 =UTC8050 (NPN)
a2 ID2 = ID Innovations ID2
2l 10 O o ai
. - Jg — * Please Note the ID2 has an
o3 80 internal tuning capacitor of
o 70 1.5nF and this makes the total
tuning capacity = 2 3nF
- B |

The 3.1Khz Beeper Logic 1s
centered for most Beepers in
range 2.7-3 5Khz

UM 2,19 AseeslFauves ID-12

Output Data Structure — ASCII
| sTX(@h) | DATA(10AsCI) | CHECKSUM(QASCI) | CR [LF| ETX(03h) |
[The 1byte (2 ASCII characters) Check sum is the “Exclusive OR” of the 5 hex bytes (10 ASCII) Data characters. ]

Output Data Structure — Wiegand26
1(2(3]4]s5|6|7|8]|9|1w0|11]12]13]14(15(16|17|18|19|20(21[22]23|24(25]26
P|E|E|E|E|E|E|E|E|E|E|E|E|O0|0|0|0|0|O|0|0|0|0|0O]|O]|P

Even panty (E) 0Odd parity (O)

P = Panty start bat and stop bit

Output Data Magnetic ABA Track2
| 10LeadingZeros | 85 | Data | Es LCR | 10Ending Zeros |
[SS is the Start Character of 11010, ES is the end character of 11111, LRC is the Longitudinal Redundancy Check.]

s 220 juUuvudeyaves ID-12

WU ID-12 iyamuassiiamsadengluuudeya (Data Format ‘18843
gﬂLmue’fiyuagif"fuﬂ';mc?fmﬂ1ﬂﬂﬂ°l%ﬁau"lwmmiﬁ'a@umﬂn 7 (Format Selector +/-) a1/l 2.20
ASCII Format n3ditdonddoyasynsunuy ASCII §1%5U ID-12 sz doada
Amaiinesyesnesaoynsuiliu 9600.N,8,1 (Flow control None) 4 Tag d99o3a1189 ID-12
92891NUU1A 16 Bytes 1J52A0UA10 Data 18z Checksum 1iuswa ASCII g1uFUA (2 ASCII

709NYT 1 Byte)



Output Format — Serial ASCII 9600, N.8.1
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02 10 ASCII Hex Data Characters
(lbyte) | (10bytes)

2 ASCII char’s Checksum
(2byte)

CR
(1byte)

LF
(1byte)

03
(1byte)

3191 2.21 Output Format 493 ASCII

fregraru 14 Hyper-Terminal 9600,N,8,1 (Flow control None) Lﬁ®é1uﬁ11ﬁ}ﬁﬂgﬂ

®©041A21EE34ES

v

Y
HUWANNI ID-12 ILBIUAIIN Tag IARIL

Start Byte @& =02 ASCII

End Byte ’ =03 ASCIIL

Hex Data 5 Bytes = 041A21EE3A ASCII

1ag Checksum = E5

Y
a o % < . [
Ta8 Checksum (NA1NN1511 Data 149 5 Bytes muﬂmgﬂummgmamuéjﬁ Exclusive OR NULLDY

o I Aa = 3
wasndun g uaunnonasa

D-fl-]_-,ex S5 ].A'JL]JEK D 2 lhex Sx EE}JEK D 34]1.,3}: = Eﬁhﬂ

. & ¥ & & v &
Wiegand26 Format Jujiuunvesveyaly Tag upuniagagainiiuinnsgiv

RAEIMNITY Huua 26 1a Tu 26 U 1U52NOUA0 Facility code Y11A 8 1@ 1ag ID number

YA 16 U0 §IMSV Facility code ¥11@ 8 Ta anysaimmuaiiusia’ld 256 5¥a (0-255) dau

ID number eusatruaiiua D 14 65,536 ID (0-65,535) 111990140 1nAV0ITIUIUT el

@ o o 3 . . @ {
siadsenimymhidun1d Uuuufuves 26-bit Wiegand 11aa6901519% 2.4

A1519%N 2.4 26-bit Wiegand Format

in ANNHINY
Bit 1 Even parity 52111910 2 94 13
. 2 . = A 3
Bit2 049 Facility code (0 94 255); U# 2 1y MSB
. =2 =2 a <3|
Bit 10 94 25 ID number (0 94 65,535); U@ 10 114 MSB
Bit 26 0dd parity 5511909 14 94 25
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Data 1 Signal
(White Wire) yvoh ——THF-—"7""/f-"""""">""~"~"~"~"~"=~—-—-—---

Data 0 Signal
(Green Wire)

| |
v
'«— Tpi —p'e Tpw Pe— Tpi —» 0

gﬂﬁ 2.22 Data Bit Timing U84 Wiegand26

=

H H 4
anvgmalasunlasvesdyanudoyanansdazdi 2.22 19 Data0 11az Datal 2]

a g Y v w1 A 1 o 1 [
ﬁmuza@%mﬂu High (lfl’iﬁﬂﬁzﬂﬂ Voh) ﬁ]uﬂﬁ51’]\1%3@’]1!1“]%}@%7]%5@1\1‘]2@%93&!@1 mmu%ﬁlﬁ

o

¥ Ya & o o o o 1 o o @ o '
doyam liinailudyanaiaday @i vol) Tasdaanaiadueans Datal tag Data0 3¢ laj

U

v 9 [

o do o !
NUYDUNU Iﬂﬂ"lju']ﬂ“lJ@Qﬂ'J’]iJﬂ%’]\i%fNWﬁﬁGﬂﬁfﬂllﬁgqqq@ ﬂgllﬁﬂﬂﬂﬂﬁ151\1ﬁ 2.5

M 2.5 Frnavesdyaudoya

Feyanwal Ao ¥anm
Tpw Pulse Width Time 100 us
Tpi Pulse Interval Time I ms

2.3 laulasaeulnsaraos
Y

4 1 [ 9 Ay A A 9
luTasaouTnsameinnasznaa oUWy RFID 14 luauideilinenlde

ex®.

A t:! q’j LI~ o’d’ Yo a
2 asznane MCS-51 wag PIC dansgiuluTasnou Tnsamesn lasuanuilongs
d
2.3.1 lulasaeulnsames MCs-51 [11]
A A v o 3 P
MCS-51 Mmaonldilumos P8ovsIRD2 iy luIasaou Insamesuuy 40 v1 ¥u19
8 1 Hiaennuswuuular 64 KB miteanuiideya 1 KB S1uiunesaduna-o1miua 1
9 = Y Y] ~ =~ wad o dy
19911 4 wose Ulaseasumeluaegii 2.23 uasligaauinous Al
o 4 [ 4 A o a
1) Mauiussay 5 1ad uazidya aunn 0-40 MHz
2) HueaNuImuULaY 64 KB
3) 3035UBATIFYRIMUINN LU 12-clock 18 X2 mode (6-clock)
a r'd a o 4
4) BUWN-LOIMUN 8 VA 91U 4 WOTA
=1 o Jd o a %
5) Wlnwesaaniwes 16 4a 3 a2

[ a Jo U
6) S’E)\‘liﬂﬂ']'i’ﬂum’ﬂﬁiwllﬁj‘iﬂﬂ 4 1o



7) 5995U52AUA0IN TTL tlaz CMOS

CRYSTAL
OR
RESONATOR

HIGH PERFORMANCE

|
80C51 GPU I
AN |
|
64 kB S —
CODE FLASH UART DU E—
INTERNAL |
BUS |
1kB ¢ ;
DATA RAM SPI <:7>
|
PORT 3 Ca— TIMEROD [T
TIMER 1 —
|
PORT 2 < TIMER 2 DI
1—'—.'
|
PORT 1 pos ! S
(T PrRoGRAMMABLE [T
COUNTER ARRAY |
PORT 0 I
| WATCHDOG TIMER |
|
OSGILLATOR |
|
|

517 2.23 Taseadaneluves PROVSIRD2

P1Om2 [1] . [40] Vpp
P11T2EX [2] 39] PO.0/ADO
P1.2/ECI [3 ] 38] PO.1/ADT
P1.3/CEX0 [4 | 37] PO 2/AD2
P1.4/3SICEX1 [ 5 | 36] P0.3/AD3
P1.5MOSICEX2 [ 6 | 35] P0O.4/AD4
P16MISOICEXS [T | 34] PO.5/ADS
P1.7/SCKICEX4 [ 8 | 33] PO 6/ADE
RST [@ | P89VSIRB2FN [32] P0.7/AD7
psoro ] FINEIRCIT [
P3AMXD [11] pgevsirp2Fn |20] ALEPROG
P3.2/INTO [12] 29| PSEN
P3.3INTT [13] 28] P2 7IA15
P3.4T0 [14] 27| P2.6/A14
P35M1 [15] 26] P2 5/A13
P3.6/WR [16] 25| P2.4IA12
P3.7/RD [17] 24] P2.3/A11
XTAL2 [18] 23| P2.2/A10
XTALT [19] 22| P2 1/AS
Vss [20] 121] P2.0/a8

511 2.24 MIIAAUKUIVIUDI PSOVSIRD2

U

—_——,———— e ————— e ——— e e —

21



2.3.2 lalasneulnsatass PIC [12]

4 £ av dyd! Y 4 £ a
luTasneuTnsames aszga PIC ¥alunuidetidenls e PIC16F876A Hanan

aw < 4 < = a a 7o
Tagu3HN Microchip 1Ju'luTnsneuInsawesviamnuailsz@nsnimgs uazlilsnsunms

v
a

o 3 A 9 d? =2 9 @ A v o ' o
NNIUUTIN Lﬂuﬂuﬂniwmmu MIﬂﬁ\‘iﬁiNﬂWﬂiHﬂﬁzﬂ‘ﬂ 2.25 Ll'ﬁ$?j‘lJLL‘]J‘Uﬂﬁi]ﬂﬁHL‘HuQ"lﬂﬂﬁ

=
319 2.26
13 5 c Data Bus PORTA
Flash I v < RATIANT
Program ] +—=>| RA2IAN2VREF-ICVREF
Memory RAM — < RA3J/AN3INVREF+
8 Lfl";_'bitf“k File 4R RA4TOCKICIOUT
L Registers < RAS/AN4/SSIC20UT
Program
Bus 14 RAM Addrt®
A Adar MUX
Instruction reg
| Direct Addr 7 Indirect PORTE
| [ B4 Adar 1 -[X] RBOINT
g » RB1
FSR
L A T8 Res
. | 1 RB3/PGM
. — || e R
L — — RB&
j--\r_.- - RBG/PGC
Powerup 3 MUX 4 RBT/IPGD
17 Timer
Instruction Oscillatar
Decode & [<— | Start-up Timer
ALU
Cantral Power-on
Reset g [ PORTC
| Timing | . Watchdog ’—/—' B RCO/T10SOITICKI
E— Generation [~ Timer W reg < RC1/T10SIICCP2
OSC1/CLKI Brown-out - RC2/ICCP1
0SC2/CLKO Reset iy - RC3/SCK/SCL
In-Gircuit ’— < RC4/SDIISDA
Debugger - RC&/SDO
Low-Voltage RCETXICK
Programming RCT/IRX/DT
MCLR VDD, Vss
Timer0 Timer1 Timer2 10-bit A/D
\ [ Il 1L
0 [ 1l | I 1
Synchronous Voltage
Data EEPROM CCP1,2 Serial Port USART Comparator Reference
Device Program Flash Data Memory Data EEPROM
PICTBF8T3A 4K words 192 Bytes 128 Bytes
PIC16FB76A 8K words 365 Bytes 256 Bytes
Note 1: Higher order bits are from the Status register.

517 2.25 Tassadranelues PICI6F876A
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28-Pin PDIP, SOIC, SSOP

(

MCLR/Ver —=[]°1 28] =— RB7/PGD
RADAND =—=[] 2 27[] =— RBBIPGC
RATANT =—= [] 3 26[ ] =— RBS
RA2IAN2IVREF-ICVReF +—= L[] 4 < 251 «— RB4
RAIANIVRer+ —= L] & - 24 ] == RBIPGM
RA4ITOCKIC1OUT =—=[] & g 23] = RB2
RABIANA/SS/C20UT == [] 7 P 22 | = RB1
vas—=[] 8 5 21[] =—= RBO/NT
osclcLk —=L] 9 P 20[] =— voo
0SC2/CLKO =—[10 5 19[] =— vss
RCOMI0SOITICKI =—= []11 o 18[ ] =—= RCT/RX/DT
RCUTIOSIGCP2 =—=[12 17[] =— RCBITX/ICK
RC2/GCP1 =—=[]13 16[] == RCE/SDO
RC3/SCK/ISCL =—=[]14 15[ ] =—= RC4/SDI/SDA

3191 2.26 MIIARIHUIUIVDI PIC16F876A

Taseadnelulsznoudie g viuteanusi ldsunsy vireanuiidoya

1 a 1 4 o o a 1 a 5 o S 4
AIUAAADNDIA ﬁ")‘lﬁ]ﬂfﬂiﬁﬂJﬂﬁﬂluTWﬂ']ﬁ'Juﬂ'J‘UﬂNﬂ"lﬁ’f)um’l’)iiWﬁ uazﬂm%uﬁuq GIETRE

9
[ v A

TaslnaautiandiAyaadl

o v qU = o

mﬁﬂmmmm 35 a9

Y o a =1 a =3 9

)] mmﬂwmmwmmﬂﬂmmamm fJﬂL’JuﬁﬁﬂﬂlﬂﬂT‘]JiLLﬂill

[ =

1) 1)1 RISC CPU
2) nszimmdalael
1¥a0ql4Aa

3) MuNANNDFYQIAUINNT 0-20MHz
4) wieaNu Tdsunsuuuuuay 8K x 14 Word
5) wWuleANUIUOYA 368 bytes
1 o a A 4] 4 1
6) ADUAUDUHAINULADUIADTTNN 14 U1iaa
=\ d a 4 4
7) UNDITADUNALALIDINKWA 3 WOIA (Port A, B, C)
o P 4 A a 1 4 [
Hendududanuriemisaomdeyanudy ldannateunas ilenlssuiouny
S AAY Yo Aa [} ] A < A Y]
luTnsnouInsamesuid lasuaNuiongeauInsuniy Av PIC6F877 AUNUIZIMiounuyn
U523 en3uSIUINVIN PICI6FS77 H11nAIA0N 40 115128 VO Port ¥1AA31 1 Port

TGN
A D)
2.4 M3deaIIVRYA
2.4.1 M3TOMIHUVOUNIN

A o ' 9 A A
ﬂh‘ﬁ’ﬂﬁﬁ!,!,‘]J‘Uaigﬂii\luu%mm\‘]’ﬂ@ﬂ]lmﬂu 2 1Ly ﬂ’f]ﬂ’]iﬁ‘@ﬁ'ljaigﬂjullﬂu

Falasiid nazmsdomsoynsunuvoz ¥ Iasiie
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msdemsuuudInsidezlidyagauiinsuegiumssunaz dadynIuaie

3 o9

[ Ll =4 9)

v g a v SN 4 a s 2 £ o3|
G]'JE]EJ'Nﬂ?ﬁﬁﬁﬂlﬂyjallﬂﬂcﬁﬂiﬂiuﬁﬂﬂﬂﬂ‘(’J‘]JE]ﬁﬂﬂlE]\‘iﬂ@ll‘W’Jm@ﬁ %Qﬁ?ﬂlﬁuﬁuﬂﬂglﬂuﬁ'lﬂﬂlﬂﬁ

k4
3 a 3 %

1 Y % I 9 a 1 4 @
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DB-9M Function Abbreviation
Pin#1 Data Carrier Detect CcD

Pin #2 Receive Data RDor RX or RXD
Pin #3 Transmitted Data TDorTX or TXD
Pin #4 Data Terminal Ready DTR

Pin #5 Signal Ground GND

Pin #6 Data Set Ready DSR

Pin #7 Requests To Send RTS

Pin #8 ClearTo Send CTS

Pin #9 Ring Indicator RI

A o ' Y A ]
gﬂ‘l/] 2.34 MUY HIVIU93 DB9 Connector uazwummﬂmm

2.4.3 UART
UART 8011910121 Universal Asynchronous Receiver Transmitter AL EREER
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yian s YA ¥I3v09903a msmnuaals
1. Character 8 1 -128 D9 +127 char
2. Unsigned Character 8 1 0 4 255 unsigned char
3. Integer 1600 | -32,768 D4 +32,767 int
4. Unsigned Integer 16 19 099 65,535 unsigned int
5. Long Integer 32 U@ -2,147,483,648 aR +2,147,483,647 | long int
6. Floating Point 32 1 3.4x10-38 D14 -3.4x10+38 float
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Sou'lv 1 gaflan Ui 1
934
Wou'ly 2
934

A

sa A
galandun 2

{ s & ° S .
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Wandu switeh fuilesndunldlumsnlSenfeudoyanatesn maudeon uaoz i
awsanlseufeuuuuunnimsedesni 1d uavznlSeufsudoyatumined
suyy
switch (v)
{
da A
case x1 : %ﬂﬁiﬂ‘lmﬂ 1 break;
da A
case X2 : %ﬂﬁiﬂ‘lmﬂ 2 break;
sa A
case X3 : G]gﬂWﬂﬂ“Im‘ﬂ 3 break;
sa A
case x4 : G]gﬂWﬂﬂ“Im‘ﬂ 4 break;
o Jw {
default : gaHanTUN 5
}

o S . o w [ [ 3 o
Wandru switch azdls v vulSeuiioniy x1 — x4 §1A5900 case lanihauage

o Lo 3 ] [ 4 3 o U Lo [
Handuiiu i1 luasesiuoulala Ahawgailaddunas default
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51 2.38 Trladmsamsiauvesilendu switch
o & s P o D} ° J A
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fMnuanIsTuAY
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End
{ s & o 7o
711 239 Tadmsamsirauvesileandu for
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v 9 1] 3
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siuy
do
{
s
yalanau
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il aridn
b

s & ° o Jo .
31N 2.40 Teladnsamsiiauueilansu do while
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while (A329e0DROU 1)
{
s
yafland

}

while (1391 1)

do {
agailandn
}

I

End

{ s o o o .
31U 2.41 Trladmsanmsiauvesilendu while
d0:1 I~ o o"e‘J o { v o [ d‘o 4 o
WanFu goto WuilanFusimininse Taa ldsdumdansvuaiiedumssiau
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sum=0

\

start:

A

sum=sum-+1

v

goto start:

g1l 2.42 Tladndamshauvesiladiu goto

2.5.2 MBWOAIBNVA (Assembly Language) [14]

= I a P =
MBWOAEUUD (Assembly Language) (Hunmipineuiuaosnmsieou Tusunsuey
Yo 1 a’j d’ 4‘ @ o Q'J 4’ A’ Y 1 9 ] o q‘/
l¥frdadus odonNUHNIBUNUIHAM TV B AT e 1 d1eaen1s 1911 15U A1da
1 = 9 9y A~ < 9 Y o A
MOV 80110910 MOVE uedams Teudedoya iwomonTisunsudia doalddulaniuin
~ 1 J o o A . A J a
(901 O FIBNILADS (Assembler) M1M5Halun1¥UATo9 (Machine Code) ma"lvlagmﬁu
Y
9 o ] o Lo
%A (Hexadecimal File) 91011391 lliweuasluniisanusivedlulnsaouInsaaesae il

k4
[

~ = 9 ak 9 a Jd a 4 ~
iﬂﬂgﬂ‘ﬂ 2.43 HEAne IASIEI VDI B LN UaTIsENEVAIY Waﬂmm 4 laa A9l

Lable Mnemonic Operand Comment
AddR1 : ORG 0000H ; Start address
MOV A #00H ; A=00H
MOV R1,#05H ; R1I=05H
ADD AR1 ; A=A+RI1
DINZ R1,AddR1 ; Jump AddR1=0
END

71 2.43 Tasead e Tisunsuvesmumodauua

A oA 9o ° ' ' 9
Waan 1 Label ¥imuadwmislumsnssTaa uiomaisenTisunsudos Audu

Y o o a9 Y A
AEAIONYT UANIAIUIATBIHNIEADAADY )
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2.6 ¥o39103 neallviass nazqinsaililsunsy

2.6.1 TJ5unsu Keil uVision3 [15]

T1l5un33 Keil uVision3 gnadialasyusim enfu aida fluaeylwassau ¢
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@1 Inaans) awnsnwen 1150n5u35095UAIUY 2 Kbyte

K2 mVision3 - [Text1] (=113
B)fie Edt View Project Debug Flash Peripherals T i =] x|
=T | /Gi Toolbar l—_|. i

& @ B[] 5 e P m
| Cla=
Project Wiorkspace - x I :]
Project
Workspace ( Text Editor )
=

L el | i
E % Testl
x p :-J

Output Windows ] -

g’ T T T I\ Buitd £ Command }, Findin Fie 4 el |»

For Help, press F1 L:1 i R, .2

51N 2.45 druilsznoUUBINTIAI Keil uVision3

u

7 . .. Y
09R152NVVBY Keil uVision3 Usznouaie

I 1
Project Workspace Aunthanauaaalysen g
. I o .
Output Windows uaaswamsaou Ind lWanims Build Target
4 1
Text Editor WunweuTdsunsuy
Toolbar IN3094DUDY Keil uVision3

Y I [ o o nsll Y v dy
M3 1gaun ligeemin ensaiauduaou 1dail
1) lalsunsu Keil uVision3

2) a51eldsnlny Project > New Project



kZ avision3 - [Text1]

@Eile Edit Wiz Eru:uject' Debug Flash Peripherals Tools 3WCS  window |

;-I% E-q n ﬁ | MewPrq\ject... | Batl—

menrt%isionl Froject...
% Open Project, .,

| & =

| Project Workspace

’— é Zomponents, Environment, Books, .,

ﬂﬁ 2.46 RERR New Project

:/, A [ o 1 o R
3) aa¥e ldsatazmruadumuslumsdunn

4) 1denlulasnouInsamesnldanuy

Select Device for Target "Target 1°

CPU

Vendor.  Philips
Device:  PEREIRDZ I Use Extended Linker [L<51] instead of BLS1
Toolset:  CH1 I~ Use Extended Assembler [£551] instead of &51

[ata base Drescription:

----- £3 PaILPCI4M 40kHz, 5% alt 8051-based Microcontraller with 32 140 lines, 3 Timers/Cou
..... £ PRILPCI408 B-channel PCA

----- £3 PaaLPCas2

----- £3 P8ILPCIE4

----- £3 P8ILPCIEE

----- £3 PBILvEIRB2
----- £3 PaaLvEIRC2
----- £3 PBILVEIRD2
----- £3 P83v51RB2

----- £3 Pa3v5IRC2

>

----- £3 PagvEED
----- €3 PavEe2 &

|~
|

QK Cancel Help
I I |

5141 247 maden luTasnouInsames

5) a9 WdTUsunsumun® File > New

Y7 prod - aVision3

Eileigdit Wieww Project Debug Flash Peripherals Tools SWCS Window

I
=

e, . Q| g
= opdit., Chrlg

e

=l

ﬁ Save Al

317 2.48 myade g unu
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6) Tma@eulsunsumund vazunniulng c
7) N1M3 Add g 1311 T)519a Add File to Group ‘Source Group 1’
8) 11113 Build target tionou Ind lWlanadavu

o 129 a @ ~
9) wamsnow lwawn lulideranain vzuaasdagili 2.51

¥ prod - aVision3 - [F:ARFIDABOS1\4\pro4.c]

@Eile Edit Wiew Project Debug Flash  Peripherals Tools SWCS

SE=A =R A
& ) & ,ﬁ\"|Target1 j
Project Workspace x
0mEl/ /Program for a
=% Target 1 002 | #include<regsl.
C | A | fidafine mort DY

Cpkions For Group ‘Source Groop 1

| Rebuild target
Build target F7

Mew Group

| Add Files to Group 'Soprce Group 1'

ﬁ Manage Components i n

Remove Group "Source @roup 1 and it's Files

gﬂﬁ 2.49 M3 Add File 131w Project

k¥ prod - aVision3 - [F:ARFIDABOS1¥\prod.c]

EEile Edit Wiew |Project| Debug Flash Peripherals Tools SWC5S  Window Help

Mews Project. .. E ’7

Import Yisionl Prajeck...

Open Praject...

Project Workspace Close Project m
= E Target 1
+-(77 Source #4 Companents, Environment, Books...
/4 Fort

Remove @roup 'Source Group 1 and it's Files

Options For Group 'Source Group 1 xA0;

Build target [~ F7

Wy

%4 Rebuild all barget files
@ Translate Fi\RFIDIS0S 114 \prod.c

g‘ﬂﬁ 2.50 197 Build target
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*|Build target 'Target 1'
linking...
Program Size: data=109.0 zdata=0 code=2420
creating hex file from "prod"...
"prod4" - 0 Error(s), 0 Warning(s).

= ¢
51 251 waawamsnon ng

k£ prod - aV¥ision3 - [F:ARFIDABOS1¥4\pro4.c]

Eﬁile Edit “iew |Project| Debug Flash Peripherals Tools SWCS  window Help

g = Mew Project... El—

Impork #Wisionl Project...

@ |_| I_"I Open Project. .. 1
Project Wiorkspace Close Project m
=
+-[(7 Source € A4 Components, Environment, Books...
Select Device For Target 'Target 1' e
| Options For Target ‘Target 1' | ®AOD;

s

31 2.52 ueraanih Form Layout

10) imsaelid HEX e lddmsumsTisunsuadlulnsnouInsaaos
Taeiaen Project > Option for Target ‘Target 1’
11) Anrhang Options for Target 1aen Output > Create HEX File

12) 91113 Build Target 9na33 9218 118 HEX u)aawiain .C vive i) 1991

ao )

Options for Target “Target 1°

X

Device | Target Output | Listing| C51 | 451 | BLS1 Locate | BLST Mise | Debua | Utiifes |

| Select Folder for Objects. .. | Mame of Executable: |DTU4

' Create Executable: Mprod

Iv Debug Information ™ Browse Information

v E[T%te HE¥ File HEX Format: [HE%-80 -
" Create Library: Sprod.LIB [” Create Batch File
After Make
Iv Beep'when Complete [ Start Debugging

™ Run User Program #1: | Browse...
™ Run User Program #2: | Browsze...

QK | Cancel | Defaults | Help

gﬂﬁ 2.53 UAAINII Form Layout
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2.6.2 11/51un35% Flash Magic [16]
I ) [
Flash  Magic  Wuldsunsudmsumsariulnaa’leld HEX  asuu
S R a o a g a
luTlnsnouInsaaos F¥aWau1laeu5HN NXP  Semiconductor (Philips  1aw) Fuiugnaa
2 1 adq g s s
lulnsnoulnsaes Mcs-51 5191na lunsainldlulnsnouInsamesiues PROVSIRD2 vod
3 a @ J o ] 1 4 4
Philips 1% 3313 Download 11sunsuldnuuesaesinldlasdisninlulasneuInsaaesives
au iesnnamsaldeesdeasoynsn RS232 1un1s Download Tilsunsuldiui Tag'la
9 @ A Yo =) = 3 @ dy
Apsdanvasmuguouq dnululnsnouInsameson Iaelivunouasi
' o ' A s v s s
1) domedyna RS232 sznienoniaunesnuuesalulasnouInsamosin
o 1 Qi}l [ 9 % 1 Yo 4 A 9 v o M
funisvestaede RS232 wiounune lWldnuuesaionsonsumds
2) &9 Run 1151053 Flash Magic
Ao A v 0 S A
3) 1@pnfMvuA Comport muAino a1 1Alaz fvua Baud rate 1111 9600 %30 19200
A o . Aq Y A
4) 1@enivua Device 114 Av PRIVSIRD2
5) iaendmua guuumsaudeya dedn limileir luTasaeuInsamesgn Lock
135913151800 Erase All Flash
6) 1@pNMMUA Hex File 1499015 Download ANABIN1S
7) 1aon Verify After Programming

i Flash Magic - NON PRODUCTION USE ONLY
File ISP Options Tools Help

GEH QAHFVvE> v H OD

Step 1 - Communications Step 2 - Erase
[ Select Device. .. ] 89 51RD2
COM Port: |COM 4 »
Baud Rate: | 9E00 v |
Interface: | Maone [I5P) v |

Eraze all Flazh

Step 3 - Hex File

Hex File: | F-ARFID\A0S1\3\pra3 hex [ Browse.. |
Modified: ws, Fawaw 31, 2654, 163331 more info

Step 5 - Startl

Step 4 - Optionz

[ erify after programming [ Set Security Bit 1 Start ]
[C1Fill unuzed Flazh
[ Gen block checksums

[ Prog Clocks Bit
ticrocontrallers fram MxP Semiconductors Main web page at:

wi, hep, comdproducts/microcontrallers -

3191 2.54 wihaeldanullsunsy Flash Magic
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4 o o =
8) 1800 Start 1WoFI Download  YoyalnuluTasaeulnsamesaaziliing

wihawenld RESET msshawvesluTasaouTnsames Inisuduiialu ISP Mode fagil

Reset Device

Rezet the device into ISP mode niow

Cancel

o

71011 2.55 wosvnsdal¥iims Reset lulnsaouInsamed

o a 4 4 4 o 1
9) ldimanaaia® RESET nuosalulasnouInsamos niaazvelil uag
o o A 9 2 \ A A v 2 H 20 v <
FunawiuTUsunsusuduiiau eutuaouaegiaen 13 Faludusoutilisoauasa
Y o a 4 A 4 =) 09/’ £ A Y
10) I¥imsnaaiay RESET  nuesalulasaeuInsamosonasenilauie 14
A Y o = o < SA Y o
luTasaouInsaassisudusiinu FesdunamiululasaouInsamos suduniiauaiy

v A

Tusunsun'1d%i1ns Download lJudsius

2.6.3 11/5uns3 MPLAB IDE ttaz HI-TECH C [17]
MPLAB IDE ifusesvlasiussyasesieluns@eulusunsu’l’
ATUR AU Text Editor AmSuidouianiun C naz Assembly
HI-TECH C Complier SuTsunsumlanmu ¢ iflunimunios Feas
WU MPLAB IDE
dmsumsldnuamnsoeiuieediniig W%@Ngﬂﬂixﬂ@ﬂﬁdﬁy
D adeldsen Project > Project Wizard
2) nguindeusuldidon Next
3) hmsiden’luTasaeuTnsameiilfoy
4) 1don Complier #1 MPLAB IDE ¢y H-TECH € iy defautt 13udn
180N Next
5) MM 3a31a New project Faito
6) 'l File > New titeiila Text Editor
7) weulilsunsumun C
8) 1113 Add 1dsunsuniy C 1u Project

9) thmaneulng uazadelWd HEX



] 9 ] 1
diorunniuasunz 18 1Wd HEX uuie TusunsuasuululasnouInsames Fa0101%

ao5Wu3 Tsunsy PICki2 A4

# MPLAB IDE vB.73

File Edit View REESEES Debugger Programmer Tools  Configure  ‘Window Help

Profect wizard... @gg = Q ‘ - o

Mew, ..

QpEn. ..
Close b
Set Ackive Project »

Quickbuild {no .asm File)

Package in .zip

Clean

Build Configuration 3
Build Options. .. 3

Save Project

Save Project As...

Add Files to Project...

Add Mew File to Project..,
Remaove File From Project »

Select Language Toolsuite. ..
Set Language Tool Locations. ..
Yersion Contral, ..

PIC1EFE764 Wil zdoc bank 0

5191 2.56 MIAF19 Project

U

Project Wizard |X|

Step One: r.‘

Select a device %/{é}

Device:

FICIBFETY |
PICIBFE77A,

FICTEFEE

FIC1BFE82

FICIEF&83

FICIEFE84

PIC1BFER5

FICTEF 87

PICIBF13

PIC1EFa14 Cancel ] [ Help ]
FIFRFA1R =

5141 2.57 madenes lulnsneuInsames
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Project Wizard

Step Two:
Select a language toolsuite

Active Toolsuite; HI-TECH Univerzal ToolSuite

Toolzuite Contents

HI-TECH &AM 5| C Compiler

Location
|I::\F'rogramFi|es\H|-TECH Software PICCA S 324 binbpice. exe | [ Browse. ..

Stare tool locations in project

[ Help! My Suite lsn't Listed! ] []5how all installed toolsuites

[ < Back ]L Mext > J[ Cancel ][ Help

51/1 2.58 M31@8n Complier

U

Mew Project

Froject Marme

| ProjectD oorlock |

Froject Directary
|F:\F|FID\F'roiectFIFID | L Browse. .. J

o) [omea ]

5111 2.59 @319 New Project

 ProjectDoorlock - MPLAB IDE v8.73

Edit “iew Project Debugger Programmer Tools

Add Ne%ile ta Project. .. . ‘ ?

Configure  Window Help

| pebug Vi@ HBGwo EE  C

Qpen... Chrl+0
Close Chrl+E

Save Chrl+5

Save A5,

Save Al Chrl+Shift+5

Cpen Warkspace.,.
Save Workspace
Save Workspace As, ..
Close Woarkspace

Irnport,. .
Expork...

519 2.60 11la Text Editor

U
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" ProjectDoorlock - MPLAB IDE vB. 73 - [F:\RFID\Project RFIDApic_doorlock.c]

:l File Edit View Project Debugger Programmer Tools Configure  Window Help - | 8 X
D@l i mE | Sasnn ?|J§EWQ%‘0|!! J Checksum: 0xDfci
I =
finclude <pic. h= -
Ff configuration =
i
__ CONFIG ( Ox3F3E ): Sfoconfimuration for the microcontroller
£ define
£
gdefine rs BAD FARE pin of the LCD display
fidefine e RCE F/E pin of the LCD display
Fdefine b_light RCa fibacklight of the LCD display (1 to on backlight)
fdefine relay PLL fimagetic lock{active high)
#define lcd_data PORTE ##LCD 8-bit data PORT
fdefine led RC3 Sflediartive highl
gdefine dacad RC1 fidatald (green wire) of RFID reader
#define datal RCZ #/datal (white wire) of RFID reader
#define swl Rig fibutton to save IDiactiwve low)
#define KX _PIN RC? S/Bx pin on PIC
#define TH_PIN RCE F4Tx pin on PIC
Af function prototype tevery function must have a function prototypel
£
woid init (weid) ;
woid delay{unsigned long data) ;
void send configiunsigned char data) ; |
0 | ¥
I PIC16FE76A Wi zdcc bank 0 | Ln &, Col 37 b}

517 2.61 Weuldsunsumui C

U

- ProjectDoorlock - MPLAB IDE v8.73 - ProjectDoorlock. mcw

File Edit Miew Project Debugger Programmer Tools  Configure  Window Help
| D@ imE [ =nw AN 2| bebus Vi HBao EE | c

M ProjectDoorl... |._| |E| |§|
sy~ B F:\RFID\Project RFID\pic_doorlock.c

= @ ProjectDoorlock.mcp®

Creat§5ubfolde .

Filker...

D Other Files
gdefine rs Ran RS pin of &
fdefine e RCE /FE pin of th
gdefine b_light RC4 ffbacklight o
fgdefine relay RAL Jfmametic lo
4 ¥ fdefine lcd data PORTE F/LCD 8-bit d
I I fdefine led RC3 fflediactive
Ej Files 4@ Symbels fgdefine datald RC1 S rdatal{green
fgdefine datal RCZ S rdatal (vhite
fdefine swl Rhd Sfbutton to =
fdefine BX_PIN RC7 FFBx pin on P
HAe £dwe TV MTE nes Mt ma T

g1 2.62 msnlWdnw € Tu Project
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Add Files to Project

Loak in: | 123 Project RFID v| Q2 =M

File name: |p\c_dnmlnck c ‘ Omen
Files of type: | Source (" a3] £ ‘ I Cancel ]
Jump to: | F:\RFID%Praject RFIDY M ‘

[ Rememnber this setting

(&) Auto: Let MPLAE IDE guess

() User: File[s) were created especially for this project, use relative path
() System: Filefs) are external to project. use absolute path

31U 2.63 1den'IWdioziiinlu Project

- ProjectDoorlock - MPLAB IDE v8. 73 - ProjectDoorlock. mow
Edit

D& |

Tools

File

Wiew WEE Debugger  Programmer Configure  Window Help

Project Wizard. ..

Mew, ..

I ProjectDocs =
Close 4
Set Active Project ]

clude <pic_h=
Cuickbuild ¢noc . asm File) ude spie
Package in .zip confiquration
Clean t=================
_fmc e

Rebuil Chr+F10 define
HI-TECH  Manual F11 P
Build Configur ation b Eine s 8

5141 2.64 M5 Build 19§ HEX

Build | v ersion Control | Find i Files |

T e T Tt e T e et T T

take: The target "FARFIDYProject RFIDYpic_doorlor
Executing: "C:\Pragram Files\HI-TECH Software\PIC
HI-TECH C Compiler for PICT0/12{16 MCUs (Lite bod
Copyright (C) 2017 Microchip Technalogy Inc.

(1273) Omniscient Code Generation not available in L

tdermore Sumrmary:
Frogram space  used 9AZh( 2466) of 2000w
Data space used 49h( 7N of 170hbves
EEFROM space used Oh({ 0)of 100k byte:
Configuration bits used 1h{ 1)of Thword (1
ID Location space used  Oh( 0jof  4hbytes

Running this compilerin PRO mode, with Omniscient (
produces code which is typically 40% smaller than in
The HI-TECH CPRO compiler output for this code co
See hitp:fmicrochip htsoft. com/pontalfpic_pro for mor

Loaded F3\RFIDYProject RFIDYProjectDoorlock.cof.

Build successtull =
v

< | ¥

51l 2.65 wamsnoulng
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2.6.4 Y1sunsu PICKit2 [18]

pickit2 Huses s dmsuTnanldsunsuaslulylnsneu Insaaes PIC Waun
TaBu5EN Microchip fWan PIC taziilu Freeware a1m13nTvaa Tusunsuldvaroes Taslsy
ssafuneiaTraalilsunsurumoda UsB msldanTilsunsu PICkie Tfunoudail

1) fhmsigendealnsal PIC Programmer fiuineaneniianesaisais USB

S A a
LED augiazan

317 2.66 M3FousioAUAIY USB

2) semellsunsuiniuganaans

AP TRIRT VRN Y

A A - J
ETJ‘VI 2.67 MIFDUADNUUDIAYANAND

3) lalilsunsy PIcki2 ag ldniaeasgl 2.68 Taslisunsnazasiaaonms

Ao lagoa Tuaia



PICkit 2 Programmer - UICOOB V1.0

File  Device Family  Programmer Tools  Wiew  Help
Midrange/Standard Canfiguration

Device:

0oog
User |Ds:

FF FF FF FF

Checksum:  FCOO

PICkit 2 connected. 1D = UICO0E V1.0

( ]

Program Memory

Source: |Mone [Empty/Erased)

@ MICROCHIP

DD PICKkit 2
[ an
[] MCLR

EEPROM Data

PICkit" 2

517 2.68 W90 PICKit2

u

4) WmM3den Device asanun 1y

"\ PICkit 2 Programmer, - UICOOB V1.0

File  Device Family  Programmer  Tools  View  Help

Midrahge/Standard Configuration

Device: Select Part- “ 0000

PIC1EFE7 ~
PIC1EFE72 B
PIC1GFE73

PIC1EFE73A

PIC1GFE74

R PICTEFE744,
FICKit 2 con PICIBFGYE 0

User 1Ds:

Checksum:

PIC1GFETT

C mcierarmm

PIC1GFES

PIC1EFES2

PIC16FEE3

Frogram Meipi-1crang W
PIC16FESG

PIC1EFES7

I

Mone [Emply/Erazed]

ﬁ'\ MICROCHIP
VDD PICKR 2

[ 0n
[] MCLR

31 2.69 @enwes lulnsaou Tnaaes

51
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o J A
5) %1m3 Import a8 .HEX N9z Iiaaasuu PIC

"' PICkit 2 Programmer - LUICOOB V1.0

File | Device Family  Programmer Tools  Wiew  Help
| Import Hesx . Chrl+I
Export Hex " Chrl+E CF
1 B4 AcytromiSource Code PRES\project.hex Cerl+1
Exit Ch+D

519 2.70 Import Hex file

U

[ <
6) notlu Write 509U T1/5unTU@5 0 99Ud@AITOAIY Programming Successful

" PICkit 2 Programmer - UICOOB V1.0

File  Device Family  Programmer  Tools  Wiew  Help

Midrange/Standard Configuration

Device: PIC1EFE7EA L Confiquration:  2F02

UserDs FF FF FF FF

Checksum:  9C15
EEEEE S Mmoo
([T [T] [T] [T] [T] [T] YOO PICk 2

EE

’ Read ] [ Wwiite l ’ erify ] ’ Erase ] ’ Blank Check ] ] MCLR m

Program Memory

Enabled Source: FARFIDAPraject RFIDProjectDoorlock. hexr

anoo 1204 1584 ZFaC 3000 O0&4 0504 0AGd 0782 A~
anos 3400 3455 3473 3465 3472 3420 3449 3464
ooLn 34635 346E 3474 3469 3466 3469 3463 3464
anls 34:ZE 3420 3400 3420 3420 3420 3420 3453
onzo 3461 3476 3465 3420 344D 346F 3464 3465
a0zs 3420 3420 3420 3400 3455 3473 3465 3472
oozo 3420 J46E 346F 3474 3420 3466 346F 3475
a03s F4EE 3464 34:E 3400 3420 3450 3460 3461
o040 3463 3465 3420 3459 346F 3475 3472 3420
0048 3454 3461 3467 3400 3455 3473 3465 3472
anso 3420 3449 3444 3420 34453 3461 3476 3465
00sa 3464 34ZE 3400 Fddd 346F 346F 3472 3420 W

EEPROM Data

Ato [mport Hex
+Wiite Device

00 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF A Fiead Device +

10 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF — Evpart He File

20 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF

30 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF & P|Ckitm2

U

Ui 2.71 msTlsunsuaSaeuysel
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'
2.6.5 gunsaili)sunsu
¢ @ J v { { a
gilnsaiaiiTnaaTisunsuasuu luTnsaouInsames dagiil 2.72 832,73 a5
Yy 2 S 9 2 o v A9 A ' v 9
1@l ua99INAAIARINY A1 AU INEEHER udazagaaIua el lvan lisunsy
J 14 A Y a I 4 1 Qa: dal
HEX asvuluTasaouInsaaes PIC laTasdodsnunouniaesHIunesa USB uaNnativiin
1 o A < 3 { %
Alda lifigunsai Tsunsy wmarll Aensoadrsiuldauedld Tagldneaslugdn 2.74 aq
' - ) A = 4 s A4 9 o
p19g9eINTaN0e 1199102995928 lu Tnsnou Insamesiues PICI8F2550 Nagdoaiinig
1vaQ Firmware 91NJMAA (Microchip) asuu  PICI8F2550 noudng lda1u'la Taoniilnan

o [ 4
Firmware 111500328 A1UNO5ADYNTN RS232 (Com Port) 18

Lagand:
1 — Status LEDs 3 - Lanyard Connection 5 —Pin 1 Marker
2 — Push Button 4 — USB Port Connection & — Programming Conmechor

bl 10 2.72 Qﬂﬂi al PIC Programmer '3; U PICKkit2 U839 Microchip [18]

51/%1 2.73 g1n3al PIC Programmer Ju PX200 904 inex [19] 1A 3U ET-PGM PIC USB

V2 493 ETT [20]
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+USE
Iy
PIC18F2550 - o
24 > VDD TGTHN
FRONT VIEW 124 * VDD TGTN 10K BC327 FRONT WIEW
Egﬁ 75 * vODIGI P
NS
(| 47
D2
+LISE - [N5a19 1 B
USE-TYPEB o -
= 4 +DAT [RA 108 16 |RCS/D+ ] M
CONI | B_-DAT [R20. 102 T5|REHD-  pag 5> A2 flifer el Bl CONZ
2 GND g|Wss Raz|5_—* ICSPCIEK Ba 5 o
o e Y I 200D Pivila <= ICSFDAT RS i
O 8] yves Ao 13 VDD TGT ADJ o GND 3 O
= Pl I na1l2_« VDD TGTFB K7 YDD TGT RN
A1 ' VPP
TORVIEW [ o R1251K O
LED1{E) A 0 WUSB  LED3 g = TOP VIEW
)
POWER | rca PO - 1 TARGET
+YUSE 0o 1 L
2 gs0u
R2 uy CE
10K, IN5Z13 4,70 pig
200 2|
PROGRAM
Ism
L RC1
c3 200 3 osC1
"L RA(2_%_ VPP FEEDBACK e
L] 1005
C4 20P ¢} osc?
| 20MHz FE2 23—+ VPPOM
14| vUSE Qs
5[] 1 mgcw
047U Ras{Z_# MCLR TGT
N 47

3111 2.74 299319309 11)50031 PIC H1U USB (PICKit2 Compatible) [21]



